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ABSTRACT

The primary aim of this article provides
readers with a discussion about specific
tools and features of two versions of the
word processing program, Microsoft Word
2003 and Microsoft Word 2007, that may be
of benefit in helping students with dyslexia
in their studies. As newer versions of Micro-
soft Word are released, so are more compre-
hensive features being offered to many
users including students with dyslexia. In
the course of this article, a selection of the
most important facilities will be outlined
followed by describing how each feature
operates, in addition to pointing out its
potential benefit for student use. The final
part of the article presents the reader with
a detailed discussion on the prospective
benefits of using word processing software
for students with dyslexia.

INTRODUCTION

The benefits of information communi-
cation technology have transformed the
academic experience of students with
learning problems (Morrison, 2007: 83), in
particular those with dyslexia. Itis, therefore,
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not surprising that the educational field is
constantly being affected by this medium
and has become an important teaching
and learning tool for both students with
and without dyslexia (Wahl, 1996: 1). The
British Dyslexia Association (B.D.A., 2010:
1) declare the potential of using a word
processor has resulted in making major
differences for students with dyslexia by
assisting and supporting them with the
writing process (e.g. organizing and struc-
turing ideas for those who have problems
with presentation or handwriting, prepara-
tion of presentations, and help for those
with handwriting problems (B.D.A., 2010:
1). The word processor is a highly impor-
tant written communication tool and
enables easy drafting and editing (B.D.A,
2010: 1) and as Keates (2002: 9) declares,
it represents an environment in which
this category of students can excel. With
the evolution of the word processor and
especially with the development of Micro-
soft Word and its abundant features, these
applications provide a better mechanism
for supporting the students with dyslexia.
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Figure 1: Range of Microsoft Word facilities
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WHAT IS MICROSOFT WORD?

The Microsoft Corporation (Microsoft
Corporation (a), 2008) describes the word
processing application, Microsoft Word, as
being a:

“powerful authoring program that
gives users the ability to create and share
documents by using a comprehensive set
of writing tools within an easy to use MS
Office user interface”

This program allows individuals to create
content and documents more quickly and
simply in a professional manner. The appli-
cation contains a collection of tools and
facilities to construct documents from a
variety of predefined parts and styles, in
addition to allowing students to compose
information within it (Microsoft Corpora-
tion (a) 2008). Lerner (2000: 56) states that
“word processing is a boon for students
with learning disabilities who have diffi-
culty in handwriting, spelling and written
composition,” whereby studies show the
greatest difficulties have been found with
aspects of grammar, punctuation, spelling,
organization and coherency (Raskind, 1993:
187). Consequently, using a word processor,
like Microsoft Word, may prove to be a key
in addressing many of the problems expe-
rienced by these students with dyslexia.

SPECIALISED WORD PROCESSING
COMPONENTS

Word processors, such as Microsoft
Word, contain a collection of features that
can greatly assist in the reading, writing
and spelling of a document, like thesau-
ruses, spell-checks, grammar checks, and
editing facilities. MacArthur (1996, Lewis
et al (in press) cited in Lerner, 2000: 454)
states these tools support the reading and
writing process by making it easier for the
student to write, correct and revise their
own writing. Lewis (1998, cited in Evans,
1999: 8) emphasises the fact that all word
processing programs should provide the
following range of functions to make
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this reading, writing and learning process
easier for students with learning disabilities,
including those with dyslexia, when this
program is being used:

- Word processing using voice input
devices with speech feedback for the task
of editing;

- Software to aid in planning and orga-
nizing ideas when preparing for writing;

- Thesaurus and dictionary;

- Software for editing spelling;

- Spellcheckers into which subject
specific academic vocabulary can be
entered; and

- Software for editing grammar with
speech feedback to assist in detecting
meaning inconsistencies.

The concept of using a word processor
in an efficient and resourceful way could
prove to be an impossible milestone for a
student with dyslexia, but at the same time,
if they can succeed in using information
communication technology, this“...can
lead to students becoming more confident,
independent users” (Fintushel, 2001: 4).

Figure 1 presents a range of facilities
in Microsoft Word that may be useful to
students with dyslexia:

SPELL-CHECKERS

The use of a spell checker can act as a
possible support for a student with dyslexia
at college. All word processing programs
come with a built-in spell checker with an
interactive error alert, such as highlighting.
By default, Microsoft Word automatically
scans the spelling of words as they are
typed and uses wavy red underlines to indi-
cate possible spelling problems (Microsoft
Corporation (b), 2010). If the user performs
a series of clicks on the word, the program
offers a short list of alternatives (Dyslexia
Teacher, 2005).

Montgomery (1997: 134) points out
that certain spell checkers and dictionaries
have the capability of locating a word and
determining its meaning from partial clues.
But the author admits that these facilities
“should be regarded as aids to discovering
spelling not a substitute for it" (Mont-
gomery, 1997: 134).

The organization AbilityNet (2002) stress
the point that although word processing
systems have built-in spellcheckers, they are
not tailored and designed for the specific
difficulties of students with dyslexia, but
look more at alphabetic similarities rather
than phonetic connections. Many computer
spellcheckers are not user friendly when
offering a correction list as quite often the
program only offers words that have the
first two letters in the spelling error (B.D.A,
2007). Furthermore, if the letters in a word
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are in the wrong order, the spellchecker
may not suggest the correct word that is
required. For example, if an individual types
“sercle,” the suggestions may be “serial,”
or "serve," but not “circle” This can lead to
further frustration for the user. Therefore,
as an alternative, the use of a handheld
spellchecker could prove beneficial as this
unit tries to interpret phonic spellings, e.g.
“sercl"for “circle” (B.D.A,, 2007).

Montgomery (1997: 134) claims these
types of tools avoid the awkward task of
locating the incorrect word and editing it by
physically typing the correct letters. There
is greater potential with these devices in
terms of composing and developing ideas.
Before using a spellchecker, it is recom-
mended by the author that the student
should provide a printout of the document
and proof read the text before using the
spell checker. This can help identify areas of
difficulty that both the pupil with dyslexia
and tutor can address. The purpose of this
allows the students to take on some initia-
tive and responsibility for their own learning
(Montgomery, 1997: 134). The Spell Check
tool in Microsoft Word 2003 is located by
clicking on Tools = Spelling and Grammar
or by pressing the F7 key (see Figure 2)
spelling errors appear in red. Should one
wish to turn the Automatic Spelling Check
on/off, click Tools = Options = click on
Spelling and Grammar tab; select/clear
the ‘Check spelling as you type’ check box
(Microsoft Corporation (c), 2010). In Micro-
soft Word 2007, the Spell Check tool is
found by clicking on the Review Tab of the
Microsoft Word ribbon followed by clicking
on Spelling and Grammar.

GRAMMAR CHECKS

The Grammar Check tool in Microsoft
Word is a type of "natural language”grammar
checker that scans and warns of conditional
problems by performing a comprehensive
analysis of text (Microsoft Corporation (d),
2010). The Grammar Check tool may not
search for all types of problems, but tries to
aim toward grammar errors that are highly
typical or most frequent. Fintushel (2001, 4)
stresses the point that “grammar checks are
not refined enough to accurately differen-
tiate between precise grammar rules, verb

subject agreement and writing styles for
students whose grammar deviates signifi-
cantly from the norm! Fintushel (2001, 4)

The Microsoft Word application scans
grammar as it is automatically typed and
uses green wavy underlines to indicate
possible grammatical errors (Microsoft
Corporation (b), 2010). Many of the errors
can go undetected and those that are
identified can turn out to be correct. When
learning disabled students are being taught
to write, these individuals want to write
without worrying about making mistakes,
but as Fintushel (2001: 4) points out “a
grammar check may counteract this objec-
tive." By using Microsoft Word, the program
has the facility of highlighting grammatical
mistakes and offers many options for the
student to select from (Fintushel, 2001: 4).
The Grammar Check is located in Microsoft
Word 2003 within the Spelling and Grammar
tool by clicking on Tools = Spelling and
Grammar or by pressing the F7 key and
the text appears in green. Should one
wish to turn the automatic grammar check
on/off, click Tools = Options = click on
Spelling and Grammar tab = select/clear
the ‘Check Grammar as you type’ check
box (Microsoft Corporation (c), 2010). In
Microsoft Word 2007, the Grammar tool is
located by clicking on the Review Tab and
then clicking on Spelling and Grammar. See
figure 3.
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Figure 2: Spelling and Grammar facility in Micro-
soft Word 2003
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Figure 3: Accessing the Spelling and Grammar tool in Microsoft Word 2007
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Figure 4: Accessing the AutoText (AutoCom-
plete) facility in Microsoft Word 2003.

THESAURUS

In order for writing to be interesting,
the student with dyslexia has to be able
to express similar ideas in a variety of
ways. Consequently, the use of a thesaurus
could be a key in addressing some of these
issues. A thesaurus can display multiple
words and synonyms for the student’s
word selection. In Microsoft Word 2003,
when a student with dyslexia identifies the
word they wish to express in an alternative
format, the user can press the thesaurus
key, i.e. Shift Key + F7 or right click on the
word and select Thesaurus. This thesaurus
facility can provide a means for students
to increase their vocabulary and, if used
consistently, reinforces that new vocabu-
lary (Fintushel, 2001: 5). This tool is a clever
and useful feature for a visual spatial learner
(Silverman, 2002: 4) and "by using this tool,
students with dyslexia become confident
independent writers” (Fintushel, 2001: 4). In
Microsoft Word 2007, the Thesaurus tool is
located within the Review Tab followed by
clicking on the Thesaurus button.

MACROS

A macro can be defined as “a sequence
of commands for performing a task” (Cantor,
2003: 1). These tasks may be simple, for
example, inserting a word, or a complex
task, such as copying data from one
program and pasting it to another. Macros
are used to record a sequence of actions
(Microsoft Corporation (e), 2010) or for tasks
that are repetitive, physically demanding or
mentally tasking. They can be written to
insert a person’s name, address or e-mail
address; insert symbols and foreign char-
acters; insert the date and time; abbreviate
words or expressions; or even open a file
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(Cantor, 2003: 1). Cantor (2003: 2) explains
four main macro creation techniques that
may be helpful to students with dyslexia
when it comes to using word processing
packages:

- Capture: This allows the user to record
commands by typing and manipulating the
mouse

- Wizards: These features guide the use
through a series of questions and automati-
cally generate a script

- Direct editing: This facility allows the
user to type or insert commands into the
macro editor

- Semi-automatic techniques: This tool
allows the user to select, insert and edit
command via a user interface to build a
script (Cantor, 2003: 2)

Macro techniques help students with
learning disabilities like dyslexia to perform
tasks quickly and efficiently by saving time,
energy and frustration. (Cantor, 2003: 6). The
Macro tool can be accessed in Microsoft
Word 2003 by clicking on Tools = Macro
— Record New Macro = Give the macro
a name or by pressing ALT + F8. In the
Store Macro In, click the template/docu-
ment where the macro is to be stored. In
the Description box, type a description for
the macro. Finally, if the user does not wish
to assign the macro to a toolbar/menu/
shortcut keys, click OK to begin recording
the macro. In Microsoft Word 2007, the
macro tool can be accessed by clicking on
the View Tab, followed by clicking on the
Macro button.

AUTOCORRECT

The AutoCorrect facility is a feature avail-
able in Microsoft Word used to identify and
correct spelling and other errors as they
are being typed (AbilityNet, 2002). An indi-
vidual can add misspellings to an “AutoCor-
rect”table that will automatically change
to the correct spelling as the user hits the
spacebar or full stop after a word. Many
students with dyslexia achieve significant
improvement by being allowed to add their
most frequent problem words to the table.
The AutoCorrect facility also has the ability
to expand abbreviations into phrases or
paragraphs (AbilityNet, 2002). For example,
the AutoCorrect facility could be used
in a sequence like: Type “y", “s" and hit the
spacebar to produce “Yours sincerely.” In
certain versions of word processing appli-
cations, auto text entries are automatically
offered as the user types on the screen.
Macros work on a similar concept as the
AutoCorrect facility, but these tools handle
commands, as well as text and graphics
(AbilityNet, 2002). An application like
Microsoft Word has the added advantage

of being able to autocorrect common or
personal spelling errors as they are being
typed (B.D.A., 2007). This tool works auto-
matically in both versions of Microsoft Word
2003 and Word 2007.

Another similar tool to using the AutoCorrect
facility is to operate the AutoComplete facility
which is located within the AutoCorrect Options
tool. To access this tool in Microsoft Word 2003,
click Tools = AutoCorrect Options; Select the
AutoText tab —» click/unclick Show AutoCom-
plete suggestions = click OK (see Figure 4).

OUTLINE VIEW

When students with dyslexia are plan-
ning to write about a topic in Microsoft
Word, the individual may find it helpful to
use the Outline facility (AbilityNet, 2002).
The Outline View is a tool that displays
document headings that are indented to
represent their level in the document’s
structure. Users who operate this tool can
also use the outline view tool to work with
master documents (Microsoft Corporation
(f), 2010).

Certain applications contain a facility
to develop an outline before a dyslexic
student writes in detail. This tool means
the student can "talk through” what is
to be written or make brief notes that
will be further expanded at a later stage
(AbilityNet, 2002). As a result, Microsoft
Word simplifies the formatting of text so
that users can focus on the structure of
the document (Microsoft Corporation (f),
2010). Users can make a variety of format-
ting changes in outline view: each heading
level is formatted with the appropriate
built-in heading style (Microsoft Word 2003
has nine different built-in styles); the inden-
tation of each heading according to its level
that only appear in Outline View; paragraph
formatting that controls the appearance of
a paragraph (indentation, alignment, line
spacing and pagination); and displaying the
outline as plain text (Microsoft Corporation
(f), 2010). To access the Outline View tool in
Microsoft Word 2003, click View = Outline
View.

LETTERS, FONT SIZE AND FONT
SPACING

Larger letters and words can prove to be
quite helpful and beneficial for those with
a learning disability, like dyslexia and for
those whose vision is not a problem. Letter
size can be adjusted in the Font Size facility,
the Font Style facility and the Zoom text
facility.

The Font Size: The Font Size can be set
to single, 1.5 or even double spacing, with
the added facility of left, right, centre or
default justification of text for the purpose
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of reading, writing and editing. The text
on the screen can be readjusted to single
spacing for the purpose of printing and
editing (AbilityNet, 2002).

Font Styles: The user also has an endless
selection of font styles and types to choose.
Certain font styles and types are easier to
read than others, e.g. a non serifed style
"Arial Text"versus a serifed style “Times New
Roman."Even a tool like a “non proportional”
font, such as “Courier Style," can make the
printed style look bigger and easier to read
rather than a proportional font (AbilityNet,
2002). To access the Font tools in Microsoft
Word 2003, simply click Format = Font or
press CTRL + D.

To access the Font facility in Microsoft
Word 2007, click the Home tab and choose
the appropriate letter size/type/style and
alignment.

COLOR SCREENS

AbilityNet (2002) claims that many
students with dyslexia who have a color
computer screen can really benefit from
using a word processing package by being
able to choose and adjust the colors that
suit them best. The user has an endless
selection of font and background colors
to choose from that can greatly enhance
the quality of life for a person with dyslexia
(AbilityNet, 2002).

SEARCH AND REPLACE FACILITY

The Search and Replace facility is a simple
but highly effective tool in Microsoft Word.
Its role is to identify and locate repeated
errors for correction. The user only needs to
type the error and corrected version once
and the other corrections will be performed
automatically and can be located from the
Edit = Find and Replace menu (B.D.A,,
2007). In addition, the Search and Replace
facility is also used to find and replace text,
formatting, paragraph marks, page breaks
and other items (Microsoft Corporation (g),
2010). To access the Find tool only, click
Edit = Find or by pressing (CTRL + F). To
access the Find and Replace tool, click Edit
—> Replace (press CTRL + H).

Type the word that the user wishes to
search for in the “Find What" field and in
the “Replace With", type the word that you
wish to replace it with, followed by clicking
Replace/Replace All.

To access the Find or Replace facility in
Microsoft Word 2007, click the Home Tab,
followed by clicking on the Find or Replace
facility.
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MICROSOFT WORD VOICE
RECOGNITION PLUG-IN

The speech recognition facility is only
available in Microsoft Word 2000 or Micro-
soft 2003 and is offered in Simplified
Chinese, Traditional Chinese, English (US/
Ireland) and Japanese language versions of
Microsoft Office (Microsoft Corporation (h),
2008: 1). Users can use this facility to dictate
text into any Office 2003 program by using
a selection of menu, toolbar, dialog box and
task pane instructions. Even though speech
recognition is not specifically tailored for
completely hands-free operation, users
will achieve significant results if they use a
combination of voice with mouse and/or
keyboard interactions (Microsoft Corpora-
tion (h), 2008: 1). The Microsoft Word speech
recognition facility is located by clicking the
“Tools" facility = Speech at the top of the
main menu.

Once this has been activated, the
speech recognition toolbar is positioned or
“floats” above Microsoft Word and appears
as a "language bar” facility with hidden text
labels (Microsoft Corporation (h), 2008:
2). First time users must participate in a
speech training task so that the computer
can recognize how the individual speaks, in
addition to increasing speech recognition
accuracy (Microsoft Corporation (i), 2008:
2). Once this has been completed, the users
are offered a variety of tools to use when
dictating.

THE ROLE OF AWORD
PROCESSOR

Raskind (1993: 187) remarks that
researchers have claimed word processing
software to be a valuable tool for assisting
students with learning disabilities, especially
when compensating for written language
problems. Sun Associates (2001: 5) state
that word processors are used by teachers
to create many types of documents, such as
lesson plans, student/parent communica-
tion and personal correspondence. Students
with dyslexia often use a word processor in
similar ways to write up research papers,
carry out projects, doing assignments and
other written documentation, all of which
can be accomplished by using this program
(Sun Associates (2001: 5)

BENEFITS OF USING A WORD
PROCESSOR

Although many facilities are freely avail-
able in Microsoft Word for dyslexic students
to use with reading and writing, it is impor-
tant to remember that these applications
contribute a variety of personal, academic
and physical achievements for them.

MOTIVATION

Word processing applications allow a
learning disabled student to produce clear,
legible typed information on the screen
that offers encouragement and motivation
for the individual to write extra informa-
tion. These programs provide the dyslexic
student with an endless collection of
formats in which to publish their material
(MacArthur, 1996; Lewis et al (in press) cited
in Lerner, 2000: 454).

Word processors allow students with
dyslexia to concentrate on the meaning of
their typed information rather than being
preoccupied with the mechanical aspects
of writing (Raskind, 1993: 187). This is a
highly important feature for them since
they can often develop a fear of translating
their thoughts into written language due
to their writing problems. Raskind (1993:
187) explains that the satisfaction of these
students knowing that they can produce
language at ease and correct errors at a
later stage is often found to unshackle their
writing abilities. For example, omitted text
can be added; unsuitable words or blocks
of text can be deleted; sentences and para-
graphs can be moved with ease; and text
can be easily bolded, centred or underlined
(Raskind, 1993: 187).

COLLABORATION

Word processing applications teach
students to collaborate in the writing
process with their tutors and colleagues
because of screen visibility and anonymity
of printed text (MacArthur, 1996, Lewis et al
(in press) cited in Lerner, 2000: 454). Lerner
(2000: 452) stresses the importance of using
this application by stating that it acts as an
excellent medium for teaching, writing and
integrating with language systems. Word
processors produce a one-to-one interac-
tive environment where students can prac-
tice recently acquired reading skills on a
constant basis (Lerner, 2000: 56).

EASE OF REVISION

The editing tool can be regarded as
being an important facility for any student
with dyslexia to use in any word processing
program. It can ease the physical burden
of revising, making it more manageable
to correct, revise and rewrite material.
Secondly, the learning disabled student can
insert, delete, edit and change the content
on the screen until the correct information
has been displayed, all by the click of a
button. Thirdly, after the necessary changes
have been made, an individual can print off
the draft, make additional changes on the
page and then make the necessary correc-
tions on the computer screen (MacArthur,

www.closingthegap.com 29



1996, Lewis et al (in press) cited in Lerner,
2000: 454). Quite importantly, word proces-
sors also allow students with learning
disabilities to express themselves at a point
that is equal to their intelligence level. Since
a word processor detects errors on the
computer screen before the document is
printed, the student will end up with a neat
and organized document that helps them
develop a sense of pride in their written
work, as well as enhancing their image as
writers. Consequently, this can resultin a
more positive approach to writing (Raskind,
1993:187).

HELP WITH FINE MOTOR
PROBLEMS

Since the role of writing can be a diffi-
cult and arduous task, the process of
typing is inherently easier, neater and more
rewarding for a student with fine motor
problems (MacArthur, 1996, Lewis et al
(in press) cited in Lerner, 2000: 454). The
word processor can eliminate the need for
retyping and makes the learning disabled
student apply more time and energy to
the most important aspect of the writing
process, i.e. thinking about the content,
editing and revising (MacArthur, 1996,
Lewis et al (in press) cited in Lerner, 2000:
454). Word processors help in the writing
process for these students by providing
a technique to allow them to write down
their thoughts and ideas without worrying
about making mistakes (Fintushel, 2001:
3). For a person with a learning disability,
writing becomes a less arduous task (Lerner,
2000: 452). By using a word processor, the
individual with dyslexia can write without
worrying about handwriting, spelling and
grammar problems.

CONCLUSION

The main aim of this article was to
explore and describe a selection of highly
important word processing components
in both Microsoft 2003 and Microsoft 2007
that are readily available for students with
dyslexia to use for the purpose of reading,
writing and spelling. A description was
provided about each facility that also
explained the importance of using these
features, followed by explaining how to
access each individual facility. The final part
of the article concentrated on describing
the benefits of using word processor appli-
cations, in general, for both personal and
academic use for students with dyslexia.
Since these students can have many diffi-
culties with reading, writing and spelling, it
is imperative that developers of these types
of applications tailor the program'’s design in
providing additional tools to support these
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student needs wherever possible. Mean-
while, academics, teachers and educational
professionals should constantly explore how
other features of word processing programs
that were not described in this article can
be specifically tailored to the individual
needs of the student with dyslexia. Further
research could concentrate on examining
this theme in more depth.
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